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1 INTRODUCTION
TimeMoto is a time and attendance solution for companies. TimeMoto enables employees to clock their work

hours. With TimeMoto Managers and Supervisors can check the time and attendance of their employees and

make reports and work schedules. Moreover Supervisors can add locations and departments.

Your TimeMoto system consists of one or more of the following components, depending on your company

needs.

1.1 TIMEMOTO TERMINALS
TimeMoto Terminals are time clocking devices with built-in RFID and PIN authorization. More advanced

models also offer fingerprint sensor or face recognition technology. The TimeMoto Terminal enables

employees to clock in and out and view their hours. TimeMoto Terminals are able to connect to a wired or Wi-

Fi network and deliver their data to the TimeMoto PC Software or TimeMoto Cloud. All TimeMoto Terminals

can also operate offline and have their data retrieved with a USB flash drive.

Available identification methods

A User must always successfully identify himself/herself at the terminal. Identification is possible through

these methods:

• PIN code (max. 8 digits)

• RFID tag

• Fingerprint recognition

• Face recognition

The PIN code must be entered in combination with your User ID.

Terminal series

TimeMoto offers two series of TimeMoto Terminals:

• TM-600 series for workgroups up to 200 Users, with:

– RFID / Fingerprint / PIN code

– 2.8” TFT Display and tactile keys

– 1 Ghz Dual Core processor

– 64 MB RAM / 128 MB Flash memory

– A maximum of 10.000 Timestamps

– Ethernet / Wi-Fi / USB Host
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• TM-800 series for workgroups up to 2.000 employees, with:

– RFID / PIN code / Fingerprint / Face (max. 400 face registrations)

– 3.5” TFT Display and touch sense keys

– 1.2 GHz Dual Core processor

– 128 MB RAM / 256 MB Flash memory

– A maximum of 100.000 Timestamps

– Ethernet / Wi-Fi / USB Host

Terminal types

All TimeMoto Terminals are suited for identification through PIN code and RFID. The more advanced

TimeMoto Terminal types are equipped with fingerprint or face identification technology. The following table

presents an overview of the available TimeMoto Terminal types.

PIN RFID Fingerprint Face

TM-616 ■ ■

TM-626 ■ ■ ■

TM-818 ■ ■

TM-828 ■ ■ ■

TM-838 ■ ■ ■

1.2 TIMEMOTO PC SOFTWARE
TimeMoto PC Software is a time attendance software solution for Supervisors. TimeMoto PC Software is

installed on a PC or laptop. Supervisors use the TimeMoto PC Software to retrieve, check and report the

attendance data from their TimeMoto Terminals. The attendance data from network connected terminals is

retrieved through the local wired or Wi-Fi network. The attendance data from offline terminals must be

transferred manually with the use of a USB flash drive. The software allows you to add/edit users, locations,

departments and clocking records. Furthermore TimeMoto PC Software allows you to implement projects,

work schedules and pay classes. Subsequently the data can be exported to payroll systems. The data on

the terminals must be synchronised manually with the TimeMoto PC Software for new attendance data to

appear and for changes to take effect.

1.3 TIMEMOTO CLOUD
TimeMoto Cloud is a time attendance software solution that is cloud-based. TimeMoto Cloud enables

employees to clock in and out with the following tools:

• onsite with a network connected TimeMoto Terminal;

• online with any internet browser;
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• with the TimeMoto App on a smartphone.

Users can access the cloud software by logging in on https://app.timemoto.com with an internet browser on

a PC, laptop or tablet.

For Managers and Supervisors TimeMoto Cloud offers additional features, such as real-time checking of staff

Presence, Reports, User management and Work Schedules.

1.4 PLUS FEATURES
TimeMoto PC Software Plus and TimeMoto Cloud Plus offer additional functionality, e.g.:

• Dynamic work scheduling

• Amend overtime hours

• Edit project code types

• A graphical planning management tool

1.5 TIMEMOTO APP
The TimeMoto App is the clocking application from TimeMoto Cloud for your smartphone. The TimeMoto App

enables employees to clock in and out and view their hours. Additionally, authorized Supervisors can view

real-time staff presence lists and edit employee records.

Users that are authorized for mobile clocking, will be able to use the TimeMoto App on their smartphones.

Search for TimeMoto in the app store of your smartphone. Select the TimeMoto App and choose to install.

Open the app and follow the instructions on the screen.
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2 DESCRIPTION AND LAYOUT
In the following the layout and menu items of your TimeMoto component(s) are described:

• "TimeMoto PC Software" below

2.1 TIMEMOTO PC SOFTWARE
In the following the layout and menu items of the TimeMoto PC Software are described:

• "Layout" below

• "Toolbar buttons" on page 11

• "Handling data in tables" on page 11

• Menu item "File" on page 12

• Menu item "Edit" on page 13

• Menu item "Report" on page 16

2.1.1 LAYOUT

The interface of the TimeMoto PC Software consists of:

1. Menu

The Menu is always present in the top part of the window. With the Menu you can access all screens of the

software.
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Under menu item File you can navigate to your preference and license settings and view the events log.

Furthermore, you can choose File/Exit to close the program. For more details, see "File" on page 12

Under the main menu item Edit you can edit clock times, Users, Projects, schedules, planning, devices and

pay classes. Fore more details, see "Edit" on page 13

With Reports you can view, email, print and export clocking data. TimeMoto PC Software offers the following

type of reports:

• Presence

• Day

• Period

• Timesheet

• Project

• Payment

• Classification

For more details, see "Report" on page 16

2. Toolbar

The Toolbar is always present under the Menu. With the Toolbar you can manage the data and settings

presented in the Data area. On the right side find the Toolbar buttons for specific actions, e.g. editing or

exporting to an Excel file. The Toolbar functionality depends on the screen that you select from the Menu.

Fore more information on the buttons, see "Toolbar buttons" on the facing page.

3. Data area

The Data area is the large area under the Toolbar. This is where your settings or data are presented,

depending on the screen you select from the Menu. With the Toolbar you can manage the data, e.g. by

filtering or exporting. Most of the data in the Data area is presented in tables.

You must select a data entry before you can use the Toolbar buttons Edit or Delete. You can also double click

on a data entry to open it for editing.

More is explained in "Handling data in tables" on the facing page

10 2      DESCRIPTION AND LAYOUT



2.1.2 TOOLBAR BUTTONS
For most screens the Toolbar offers one or more of the following buttons:

Toolbar
button

Function

Exports the displayed data to a file.

Opens a new email with a report of the displayed data in PDF format.

Opens a print dialogue to send a report of the displayed data to your printer.

Starts a new data entry.

Opens the selected item for editing.

Deletes the selected item.

Refreshes the displayed data.

For several screens the Toolbar is equipped with dedicated buttons. E.g. the screen Edit/Device has the

button Scan to detect new terminals.

2.1.3 HANDLING DATA IN TABLES

2.1.3.1 SORT TABLE

You can sort data in tables by clicking on the header of the column you need to sort. Another click will reverse

the sorting order.

2.1.3.2 REARRANGE COLUMN ORDER

You can rearrange the column order in the tables by dragging any header to the desired location.
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2.1.3.3 TOGGLE COLUMN VISIBILITY

A right-click on any column will display a list of all columns available to display. Click on the column names

you want to show/hide.

2.1.4 FILE
Under menu item File you can navigate to your preference and license settings and view the events log.

Furthermore, you can choose File/Exit to close the program.

2.1.4.1 FILE/PREFERENCES

Under File/Preferences you can view and edit the following program Settings:

Region

Use the Region settings to match the software to your regional standards for week numbering and to set the

language of the menu. Learn more about week numbering.The week numbering system depends on your
region or company policy. Themost common is the International Standard ISO 8601 with Monday as the first
day of the week. Other systems have Sunday as first day (US) or Saturday (Islamic).Week 1 of the year is
defined in the software by the selected date to include that week. ISO 8601 defines Week 1 as the week that
contains January 4.

Actions (TimeMoto Plus only)

Under Actions you can choose to Close year. The Close Year action allows the transfer of all overtime and

vacation hours from the previous year to the current year. After clicking on Close year, the software will

generate a report of the modifications.

The Close year action cannot be undone. Please make sure that the data from the previous year is
correct and make a backup first.

Clock

Under Clock you can edit the time settings for double clocking prevention and rounding. The software

prevents duplicate entries from the same employee by blocking a second punch during the set time.
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Furthermore, here you can set the time interval for rounding. Set a feature to None if you want to disable it.

Learn more about the time interval for rounding.The set time interval determines how the software rounds
incoming time stamps to the nearest option. For example with a time interval of 15minutes: An employee
clocks in at 8:07, the system will round down and register a time entry at 8:00. If the employee had clocked in
aminute later at 8:08, the system would have rounded up to 8:15.

Vacation (TimeMoto Plus only)

Here you can choose to manage vacation in hours or in days.

Database

Under Database you can install a database copy from another computer. Find out How to move your data to

another computer.

Back up

Under Back up it is possible to create a backup-file of your data. This backup can be done manually or

automatically.

In/Out translation

This section is not applicable for TimeMoto terminals.

2.1.4.2 FILE/LOG

The Log screen can be accessed through the menu bar by clicking on File and Log. The Log screen displays

the actions that have been performed on the terminal(s).

2.1.4.3 FILE/LICENSE

File/License displays information on the current software licence. A license code (and related email account)

can be entered here in case you need to activate another license.

2.1.4.4 FILE/EXIT

Choos File/Exit to close the program.

2.1.5 EDIT
Under the main menu item Edit you can edit clock times, Users, Projects, schedules, planning, devices and

pay classes.

2.1.5.1 EDIT/CLOCK

The Edit/Clock screen displays all clocking data as a list. From here you can check, edit, and add clocking

data. Anytime an error is detected by the software, the In/Out state of the line with a suspected error will be

highlighted in red. It is important to realise that the software can only provide calculation results if the

clocking sequence is valid.
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A In In sequence is also considered as valid, even though red highlights will be displayed. All odd Ins are

considered as “In”, all even Ins are considered as “Out”.

To protect the employer and the employee, the software will not allow you to delete clocking data from
the database of the software. However, a clocking item can be set to ignored so that it is not taken
into account for the hours calculation.

Find out how to add a clock time with TimeMoto PC Software.

Find out how to edit a clock time with TimeMoto PC Software.

2.1.5.2 EDIT/CLOCK GRID (TIMEMOTO PLUS ONLY)

The Clock Grid screen displays all clocking data, as well as work schedule hours and planned hours. It gives

a simple and straightforward view over the “ins” and “outs” of your employees.

• A red exclamation mark is displayed anytime the software detects errors in the clocking sequence.

• The Project legend on the right side of the screen shows the colours and the names of the different
Projects.

• You can toggle on/off the Project legend with the Project button.

2.1.5.3 EDIT/DEPARTMENT

The Department screen displays a list of the available departments. Use the Toolbar buttons to Add or Edit a

department.

Creating departments will, especially when managing a large number of Users, help you manage them and

their clocking data more effectively. It will also allow you to generate reports on specific groups of Users or

departments.

2.1.5.4 EDIT/USER

The User screen consists of:

1. List of User accounts

2. Account information

3. Account toolbar

Use the Toolbar buttons to Add or Delete a User. For the steps to add a User, see "Add a User" on page 22.

List of User accounts

The List of User accounts presents the Users in a table with their primary data and current status. Select a

User by clicking on the row.

Account information

The account information of a selected User is presented in five tabs below the list of Users:
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1. System data Tab with information needed for communication with your terminal

2. Personal dataTab with personal information among which the Joined company date. When a User
starts in themiddle of the year, it is necessary to fill the start date, so the software can start all
calculations with this date instead of the beginning of the year.

3. IdentificationTab with identification data, see also Add Identification to a User

4. Work TimeTab with information regarding the working hours annually and from the previous month.
Furthermore a Pay class can be selected for a user.

5. Vacation (TimeMoto Plus only) Tab with information regarding the vacation hours

Account toolbar

The Account toolbar consists of buttons for editing actions concerning the account information:

1. EditMakes the Account information editable.

2. SaveSaves any changes to the account

3. CancelCancel editing

4. Amend (TimeMoto Plus only)Formore details, see "How to Amend Overtime" on page 48

The terminals must be synchronised with the TimeMoto PC Software for the changes to take effect,
see Synchronise User Data.

2.1.5.5 EDIT/PROJECT

Projects are used to specify time spent on projects or activities and to register absences. The Project screen

displays a list of the available Projects. Use the Toolbar buttons to Add or Edit a Project.

Fore more details, see "Learn more about Projects" on page 23

2.1.5.6 EDIT/WORKSCHEDULE

The Work schedule screen displays a list of the available Work schedules. You can create Work schedules

and assign one to a User. The software will then compare the actual clocking actions and hours with the

assigned Work schedule for that User.

Use the Toolbar buttons to Add or Edit a Work schedule.

For more details, see "Learn more about Work schedules" on page 25.

2.1.5.7 EDIT/PLANNING (TIMEMOTO PLUS ONLY)

Planning is suited for Users with varying working days and times. For Users with fixed working days and

times you can link to a Work schedule.

Learn more about Work schedules.

2.1.5.8 EDIT/DEVICE

The Device screen displays a list of your clocking devices. Use the Toolbar buttons to scan for new devices

or add/edit one manually.
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A Device has the following properties:

• Name: this is the display name of the device.

• IP address: the IP address of the terminal, leave this field empty when using a USB stick.

• Fetching computer name: the name of the computer handling the communication between the device
and the database. In most case the fetcher should be the computer running the TA software.

• Communication key: it is possible to enter a numeric key to secure the connection between the device
and the software.

• Device language: this option allows the terminal to adapt to some languages specifications.

The Synchronize Toolbar is located at the bottom of the screen. The Synchronize Toolbar consists of buttons

for synchronizing actions for the selected device.

Fore more information on synchronization, see "How to synchronize terminals" on page 43.

2.1.5.9 EDIT/PAY CLASS

Pay classes allow you to define a basic pay rate per User, or group of Users, and apply rules that modify this

basic rate. You will be able to generate a report, and display the number of hours linked to each pay rate.

For more details, see "Learn more about Pay classes" on page 32.

2.1.6 REPORT
With Reports you can view, email, print and export clocking data. TimeMoto PC Software offers the following

type of reports.

2.1.6.1 REPORT/PRESENCE

The Presence screen allows you to view, email, print and export the current presence of your employees (In

or Out).

2.1.6.2 REPORT/DAY

This report displays the time stamps, scheduled and worked hours and breaks per employee per day for a

given range.

2.1.6.3 REPORT/PERIOD

This report displays the worked hours per employee per day for a given range and displays the total

scheduled and worked hours for that range.

2.1.6.4 REPORT/REPORT

When Report is selected, the software generates a timesheet report automatically. Every page starts with

another User. Change the report to your needs.

2.1.6.5 REPORT/PROJECT

This report displays time booked on specific Projects.
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2.1.6.6 REPORT/PAYMENT

In a Payment report the payment for a User for a selected period is specified and summed. Multiplication

factors because of Pay class conditions are also displayed and factored.

For more information on Pay classes, see "Learn more about Pay classes" on page 32.

2.1.6.7 REPORT/CLASSIFICATION

The Classification report displays an overview per use of hours booked on the default pay rate, paid leave

and the related pay class. Select the type of report (Quickbooks, Paychex, ADP, ADP2, DATEV) and click on

Export.
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3 INSTALLATION
Before you can get started one or more components of your TimeMoto system require installation. Go to:

• "Install TimeMoto PC Software" below

3.1 INSTALL TIMEMOTO PC SOFTWARE

3.1.1 SYSTEM REQUIREMENTS
Your computer needs to meet the following minimum requirements:

• Free hard drive space: 100 MB

• Display resolution 1024 x 768

• Memory: 1 GB

• WiFi or Ethernet (LAN) connection for real-time features.

• Operating System: Windows 7 and up

• USB port (for offline use of terminals)

3.1.2 INSTALLATION PROCEDURE
1. Download the installation zip-file from the provided link.

2. Extract the installation zip-file.

3. Double click on exe file to run the installer.

4. Follow the instructions on the screen.

3.1.3 SOFTWARE ACTIVATION
Start the TimeMoto PC software (double-click the icon on your desktop to start the software). You will be

asked to enter your license key and the email address it is linked to (the email address to which the license

key was sent).

Option 1: Enter the email address and license key and fully activate the TA software.

Option 2: Start the software in trial mode for 30 days and enter the email address and license key at any time

during this 30 day trial period.
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4 GET STARTED WITH TIMEMOTO PC
SOFTWARE

After completing the Installation, get started with TimeMoto PC Software:

1. "Log in" below

2. "Set your preferences" below

3. "Add a Department" below

4. "Add a User" on the next page

5. "Add Identification to a User" on the next page

6. "Learn more about Projects" on page 23

7. "Learn more about Work schedules" on page 25

8. "Learn more about Planning (TimeMoto Plus only)" on page 26

9. "Learn more about Pay classes" on page 32

4.1 LOG IN
After the Installation the program starts for the first time. The program starts with an empty database without

any registered users. In any other case the program will prompt the log in Screen. Fill in your User Name or

User ID and your Password (by default the same as your User ID). Make sure your User account has

Supervisor rights.

If you have forgotten your Username and/or password, you can unlock the application by filling in your

registration email address as Username and your license key as password.

4.2 SET YOUR PREFERENCES
Go to File/Preferences and set your language and week numbering settings. Furthermore you can edit the

time settings for double clocking prevention and rounding. Check "File/Preferences" on page 12 for more

information.

4.3 ADD A DEPARTMENT
1. Go to Edit/Department.

2. Click Add. The Add department screen is shown.

3. Fill in a Name and Description.

4. Select a Pay class if applicable.

5. Click on OK.
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4.4 ADD A USER
1 Go to Edit/User.

2 Click Add. The Add User screen is with the next free User ID number.

3 If desired you can change the User ID. However, we strongly recommend you to keep the designated
User ID.

4 Select a department.

5 Click on OK.

6 You can now fill in the User data. For more information, see "Account information" on page 14.

7 Click on Save.

8 Now add identification data to the User:

You can add identification data to the User with theTimeMoto PC Software directly. In case you have a
fingerprint or RFID device connected to your PC you can even scan and add fingerprints and badges.
For instructions, see "Add Identification to a User" below.

You can also add identification data to the User with a TimeMoto Terminal. For instructions, see "Add
Identification to a User" on page 1.

4.5 ADD IDENTIFICATION TO A USER
With TimeMoto PC Software you can change the PIN code and add a RFID tag to a User. When you connect

a fingerprint device to your computer you are also able to add fingerprints. Also a RFID device can be used

for reading out badges or tags.

For instructions, see:

• "Change a PIN code" below

• "Add a RFID tag" on the facing page

• "Add a Fingerprint" on the facing page

Adding a face must done locally for each related terminal, see "Add a Face" on page 1.

4.5.1 CHANGE A PIN CODE
The default PIN code for a User is identical to his/her User ID. To change the PIN code:

1. Go to Edit/User.

2. Double-click on a User or select a User from the list and click on Edit.

3. Go to the System data tab.

4. Click on Change password.

5. Fill in a new password.
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6. Click on OK.

7. Click on Save.

Find out how you can also Change a PIN code with a terminal.

4.5.2 ADD A RFID TAG
1. Go to Edit/User.

2. Double-click on a User or select a User from the list and click on Edit.

3. Go to the Identification tab.

4. Fill in the RFID number in the RFID field or connect a RFID device to read out a badge or tag.

5. Click on Save.

Find out how you can also Add a RFID tag with a terminal.

4.5.3 ADD A FINGERPRINT
1. Connect a fingerprint device to your computer. (If you don’t own such a device, you can Add a

Fingerprint with a terminal)

2. Go to Edit/User.

3. Double-click on a User or select a User from the list and click on Edit.

4. Go to the Identification tab.

5. Select a square that relates to the finger.

6. Click on Register and follow instructions.

7. Repeat for other fingers if desired.

8. Click on Save.

Find out how you can also Add a Fingerprint with a terminal.

4.6 LEARN MORE ABOUT PROJECTS
Projects are used to specify time spent on projects or activities and to register absences. Projects are

specified by an ID number, description and colour. Projects are key elements of the TimeMoto PC Software.

This section explains their role in the software.

Projects enable you to:

• oversee what your Users are currently doing in Report/Presence;

• quickly recognise projects or activities by their colour in Edit/Clock Grid;

• create reports of time spent on projects or activities with Report/Project;

• create a planning.
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4.6.1 DEFAULT PROJECTS
By default, the software has some pre-defined Projects. These Projects can be edited to suit your business.

4.6.2 PROJECT FIELDS
A Project always consists of the following fields:

• ProjectThe Project ID can be changed (e.g to reflect an account or job number)

• NameThis field is mandatory

• DescriptionThis field is mandatory

• Project type (TimeMoto Plus only)There are several different Project types, see "Project types
(TimeMoto Plus only)" below

• Regular out (TimeMoto Plus only)Signifies end of working day, see "Regular out" on the facing page

• ColourChanges the colour of the Project in the planning and the Clock grid

4.6.3 PROJECT TYPES (TIMEMOTO PLUS ONLY)
There are 7 Project types, which all have a different impact on the calculations in the software:

• Scheduled timeFor regular working hours.

• Assignment timeFor assignment to projects (calculated as normal hours)

• Vacation timeThe hours of the existing work schedule of the User are converted into vacation hours,
they are deducted from the vacation hours total

• Holiday timeNational holidays, reported as paid days

• Planned vacation timeTo enter vacations for Users without regular work schedules

• Unplanned timeCancel an existing work schedule (It is possible to add Scheduled time or
Assignment time over Unplanned time)

• SickProject type for sick leave, reported as paid time
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4.6.4 REGULAR OUT
When a User clocks out using a Project, the software considers that the User is still working. Using a Project

with “Regular out” checked allows to signify that the User is not working any more. This option can be used

for leaving early during work time.

4.7 LEARN MORE ABOUT WORK SCHEDULES
You can create Work schedules and assign one to a User. The software will then compare the actual clocking

actions and hours with the assigned Work schedule for that User:

• If a User has not clocked in on a scheduled working day, the software will mark the scheduled hours
as absent.

• If a User has clocked in on a non-scheduled day, the software will not count hours as overtime.

• If a User clocks more hours than scheduled, the software will result in a positive balance for that day.

• If a User clocks less hours than scheduled, the software will result in a negative balance for that day.

• If a User clocks in on a scheduled day from a Time In/Out schedule and he/she forgets to clock out,
the software will automatically assign the scheduled end time.

A Work schedule is defined by a set of rules for presence times or number of work hours, see "Work schedule

rules" below.

Work schedules are suited for Users with fixed working days and times. Go to Edit/Workschedule to

add/edit Work schedules. Go to the System Data tab of Edit/User to assign a Work schedule to a User.

Work schedules are not suited for Users with varying working days and times. For this type of User you need

to make a Planning. Planning is only available for TimeMote Plus users, see "Learn more about Planning

(TimeMoto Plus only)" on the next page.

4.7.1 WORK SCHEDULE RULES
A Work schedule is defined by a set of rules for presence times or number of work hours. TimeMoto PC

Software offers the following types of rules:
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• Hours Per Day

• Hours Per Month

• Hours Per Week

• Pause Per Day

• Time In/Out

• Time Pause

• Time Pause excl

• Time Pause incl

4.8 LEARN MORE ABOUT PLANNING (TIMEMOTO
PLUS ONLY)

Planning is suited for Users with varying working days and times. For Users with fixed working days and

times you can make a Work schedule, see "Learn more about Work schedules" on the previous page.

Learn how to:

• "Add a work planning" below

• "Add a national holidays planning" on page 29

• "Add a vacations planning" on page 30

4.8.1 ADD A WORK PLANNING
You can create a planning by assembling various templates. These templates are created by the association

of a time plan and a Project. We will take the example of a company where employees can work 3 different

shifts. One shift runs from 8:00 to 17:00 with a clocked break from 12:00 to 13:00. The second shift runs from

17:00 to 01:00 with a break from 21:00 to 22:00, and the third shift runs from 01:00 to 08:00 without break.

Firstly, we will create three different Projects, one for each shift.

26 4      GET STARTED WITH TIMEMOTO PC SOFTWARE



Let’s create templates for these shifts. Go to the ‘Planning’ page.

On the right side of the screen, you will see an empty table, click on the “Add” icon to create a new schedule

template.

Enter a name for the template (in this case Day), then click on the “Edit” button. A new window will pop-up.

You can fill-in this window in the same way you filled-in the work schedule. There are four different start

types:

• In: used to notify the start of the working day.

• Break Incl: Is used if the breaks are part of the working day. This is for information purposes only and
has no impact on the total worked hours.

• Excl break: Use Excl break when employees clock in and out for their break.

• Break impl: Is used if you want break(s) to be deducted automatically from the total worked hours
without the employees clocking for it.
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Click on ‘OK’ to save. Select the ‘Day’ Project you have created previously in the Project drop-down list.

Save your template by clicking on the “Save plan”icon.

We can proceed the same way for the two remaining shifts (Evening and Night).
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Select days on the planning at the left side of the screen, and simply drag and drop the desired template. A

window will pop-up giving you the option of leaving feedback on your operation, you can still change the

associated Project or cancel the operation. Click ‘OK’ to save.

Repeat the procedure until you are done with the planning.

4.8.2 ADD A NATIONAL HOLIDAYS PLANNING
The planning of national holidays is a straightforward process. Go to the ‘Planning’ page and click on the

‘import holidays’ button located on the top right hand side of the page.

Select your country in the drop-down list of the window that just popped-up. Leave the default selected

Project. Validate your choice by clicking ‘OK’.
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Please note: If you have deleted the “Holiday” Project from your Projects list, please create a new Project

with “Holiday” as Project type before importing the national holidays. Otherwise the software will generate an

error because of the missing Project.

4.8.3 ADD A VACATIONS PLANNING
Planning vacations will differ depending on your employees working with a regular working or planning

schedule. Also, if you have selected hours or day calculation. Below an example for hours calculation.

Let’s create a template to apply on the planning. We will name it as seen previously, but instead of creating a

planning for the template, we will specify a time range in the ‘Time plan’ cell.

This range has to cover the work schedule linked to the employee. In our work schedule example the

employee’s work schedule runs from 9:00 to 17:00.

We can fill-in 9:00-17:30 in the time plan cell. If you want to cover all types of work schedule, you can fill-in

’00:00-23:59’ in the ‘time plan’ cell.
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We do not need to create a new Project for this template, we only need to select standard ‘Vacation’ Project.

Save your template by clicking on the “Save plan” icon on the right side of the screen.

After that, we only need to select the vacation days on the planning, and drag and drop our vacation

template.

Employees with planning:

To plan vacation for an employee working with a planning, drag a template that you already use for this

employee over the days you want to set as vacation days. When the pop-up window appears change the

Project to ‘Vac.P’.

Alternatively, you can also create a template with the correct number of hours linked to the ‘Vac. P’ Project.
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4.9 LEARN MORE ABOUT PAY CLASSES
Pay classes allow you to define a basic pay rate per User, or group of Users, and apply rules that modify this

basic rate. You will be able to generate a report, and display the number of hours linked to each pay rate.

Each Pay class has a name and description, and is linked to a basic pay rate. For every Pay classes you will

define a set of rules that will modify the payrate according to the worked hours. Each rule of the Pay class will

be triggered when one or more conditions are met.

For in-depth instructions, see:

• "Pay class screen" below

• "Pay class report screen" on the facing page

• "Create and implement a Pay class" on page 34

• "Pay classes in practice" on page 37

4.9.1 PAY CLASS SCREEN
The screen is divided into two sections. On the top you will see the list of existing pay classes as well as

their base rate and possible description.

The bottom part of the screen displays the details of the selected pay class.

On the left side of the bottom screen (1), you can see and edit the basic information of the pay class. In the

middle (2) is displayed the list of all rules applied to this pay class. Finally, on the right (3) are displayed the

details of any selected rule. Rule details (3):

For each rule, you will be able to see/edit the rule name, the multiplying factor, any eventual remark, and a list

of conditions.

There are 9 different types of conditions:
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• After X hours per day: the rule will be triggered after a certain number of worked hours per day.

• After X hours per week: the rule will be triggered after a certain number of worked hours per week.

• After X hours per month: the rule will be triggered after a certain number of worked hours per month.

• After X consecutive days: the rule will be triggered after a certain number of consecutive worked
days.

• After a specific time: the rule will be triggered after a given hour.

• Before a specific time: the rule is triggered when someone works before a given hour.

• During bank holidays: the rule is triggered when a day has been marked as bank holiday (see
Projects and planning).

• On specific day(s): the rule is triggered on one or more specific week day(s).

• When using Project: the rule is triggered when an employee uses a given Project.

When using more than one condition for one rule, all conditions have to be matched for the rule to be

triggered. If the conditions to trigger more than one rule are met, the rule with the highest factor will prevail.

4.9.2 PAY CLASS REPORT SCREEN
This screen displays the pay class report as a PDF. The report is divided into two sections: on top (1) is

displayed the information per day, at the bottom (2)is displayed the totals per rules.
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4.9.3 CREATE AND IMPLEMENT A PAY CLASS

4.9.3.1 ADD A PAY CLASS

Go to the Pay class management screen (Edit > PayClass).

Click on the ‘Add’ icon located on the top right side of the screen. A new window will pop up.
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Fill in the basic information (name and Pay rate), and press OK.

4.9.3.2 ADD A RULE

Click on the ‘Add’ icon located on the left in the bottom part of the screen.

Fill in the name and factor (the factor is the multiplier applied to the basic pay rate when the conditions of this

rule are fulfilled).

Add conditions
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Select a condition in the drop down list. Depending on the type of condition selected you will have to fill

different information (number of hours, number of days, specific day or Project…). If you need to add more

than one condition, click on the [Add] button located under the last condition.

When finished, click on the save icon located on the left of the bottom part of the screen. It is possible to link

this newly created pay class with a Department or with a single User.

Link a Pay class to a Department

Go to the Department management screen. Every user in this Department will have this Pay class set by

default.

Select a department and click on the edit button.

Choose the pay class in the Pay class drop-down list. Save.

If you want to overrule the Department default, you can link the another Pay class to a user, see "Link a Pay

class to a User" below.

Link a Pay class to a User

Go to the User page, select a User and click on the “Edit” icon.
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Select the Work Time tab.

Select the pay class you want to use in the Pay class drop down list. Leave this field blank to apply the

superior Pay class setting of the Department.

Click Save.

Changing the pay rate for one User

You can change the basic pay rate for each User.

In the Work Time tab, enter the desired value in the Base rate field. This will override the basic pay rate of the

applied pay class.

4.9.4 PAY CLASSES IN PRACTICE

4.9.4.1 DOUBLE SALARY ON SUNDAYS

Create one rule for the pay class, name it and give a factor of 2. Add a “On a specific day” condition and

check the box for Sunday. Save.
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4.9.4.2 DOUBLE SALARY ON SUNDAYS AND BANK HOLIDAYS

Here we have two different rules. We just created the rule applying on Sundays, we now need to add a rule

for the bank holidays. Add a new rule, name it, and give a factor of 2. Add a “During bank holidays”

condition. Save.

4.9.4.3 SALARY *1.5 (150%) AFTER 8 HOURS PER DAY

Add a new rule, name it, and give a factor of 1.5. Add a “After X hours” condition, set the number of hours to

8. Save.

4.9.4.4 SALARY * 1.5 (150%) AFTER 8 HOURS AND *2 (200%) AFTER 10 HOURS PER DAY

Here we have two different rules. We just created the rule applying on more than 8 hours worked, we now

need to add a rule for the more than 10 hours.

Add a new rule, name it, and give a factor of 2. Add a “After X hours” condition, set the number of hours to 10.

Save.
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4.9.4.5 OVERTIME ON A SUNDAY

This case is managed with one rule with two conditions: the first condition is an “after X hours” condition, here

the value is 8. The second condition is “On specific days”, with Sunday checked. Save.
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5 HOW TO CHECK/REPORT CLOCKING
TIMES

This section describes how you can check clocking times and how to make reports.

5.1 CHECK/REPORT CLOCKING TIMES IN
TIMEMOTO PC SOFTWARE

Start the TimeMoto PC Software and Log in. Go to Report.

With Reports you can view, email, print and export clocking data. TimeMoto PC Software offers the following

type of reports:

• Presence

• Day

• Period

• Timesheet

• Project

• Payment

• Classification

For more information, see "Report" on page 16.
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6 HOW TO SYNCHRONIZE TERMINALS
This section explains how to synchronize data between the terminals and the software.

TimeMoto offers the following synchronization options for network-connected TimeMoto Terminals:

• "Set Time" below

• "Synchronize User Data" below

• "Synchronize Projects" below

6.1 SET TIME
TimeMoto PC Software allows you to set the time of your computer onto a network-connected TimeMoto

Terminal:

1. Go to Edit/Device.

2. Select a terminal with status ‘Connected’.

3. Click on Set Time.

6.2 SYNCHRONIZE USER DATA
To synchronize User Data between a network-connected TimeMoto Terminal and your TimeMoto PC

Software:

1. Go to Edit/Device.

2. Select a terminal with status ‘Connected’.

3. Click on Synchronize. A new window will pop-up displaying the differences between the data in the
software and the data on the terminal.

4. Click on TA>PC to send the data from the terminal to the software. Or click on PC>TA to send the
data from the software to the terminal.

5. Confirm with Commit.

6.3 SYNCHRONIZE PROJECTS
To send all Project codes from the software to a terminal:

1 Go to Edit/Device.

2 Select a terminal with status ‘Connected’.

3 Click on Synchronize Projects.
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7 HOW TO ADD/EDIT CLOCK TIMES OF
USERS

This section explains how you can add or edit clock times of users.

Learn how to:

• "Add a new clock time with TimeMoto PC Software" below

• "Edit an existing clock time with TimeMoto PC Software" below

7.1 ADD A NEW CLOCK TIME WITH TIMEMOTO
PC SOFTWARE

1. Go to Edit/Clock.

2. Click on the Add button. You can also right mouse click in the Data area and choose Add clock time
from the roll-out menu. The Add clock time window pops up.

3. Add the data and click on OK. Add the data and click on OK.

The OK button is only available when all required fields are filled in.

7.2 EDIT AN EXISTING CLOCK TIME WITH
TIMEMOTO PC SOFTWARE

1. Go to Edit/Clock.

2. Select the entry you want to edit and click on the Edit button (or double-click on the entry).
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The Edit clock time window pops up.

3. Edit the data and click on OK.

When you change the date/time the software will automatically create a new entry and give the

obsolete entry the state Ignore. Then the obsolete entry is ignored by the software for the hours

calculation and remains present in the list.

You can also quickly change the In/Out state

Right mouse click on the entry and select the desired change from the roll-out menu.
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8 MISCELLANEOUS
"How to handle Sick Leave" below

"How to Amend Overtime" on the next page

"How to move your data to another computer" on page 49

8.1 HOW TO HANDLE SICK LEAVE
Keeping trace of sick leave: there are 2 possible scenarios: the employee already has a work schedule or

planning, or you have to make your planning knowing that an employee is on sick leave.

8.1.1 MANAGE SICK LEAVE WITH THE CLOCK GRID
1. Go to the ‘Clock grid’ page, and select the absent employee.

2. Select the day(s) when the person is sick and right-click.

3. Select ‘Copy schedule to attendant records’, a new window will pop-up. In the Project drop-down list,
select the pre-defined ‘Sick’ Project, and click on OK.

Your employee is now registered as sick for the selected day(s).

8.1.2 MANAGE SICK LEAVE IN THE PLANNING
Proceed as if you were going to plan regular working hours. When the confirmation window pops-up, change

the Project to the standard ‘Sick’ Project.

Your employee’s sick leave is now managed.
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8.2 HOW TO AMEND OVERTIME
Over the year, your employees may accumulate overtime hours. The “Amend overtime” function of the

software will help you manage these overtime-hours.

Go to the User page and select the User for whom you want to amend the hours. Click on the “Amend” icon,

a new window will pop-up.

Click on the “Amend” icon in the top bar of the User information tab.

A new window will pop-up. you can choose when to amend the overtime balance.

You can select a type of amendment: Paid hours: the hours are deduced from the overtime balance, they are

shown as “paid hours” on the report.

Vacation hours: the hours are deduced from the overtime balance and added to the vacation balance. Other

hours: the hours are deducted from the overtime balance. You can enter a remark to give more details on the

report. Click on OK when finished.

Note: If you want to add hours instead of deducting, place a minus (-) sign before the amount of hours.

A window will pop-up, prompting you to confirm your choice.
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You will see list of all amendments made in the report page.

8.3 HOW TO MOVE YOUR DATA TO ANOTHER
COMPUTER

The TA software uses a Firebird embedded database. It is possible to copy this database and install it on

any computer provided that it is running the Firebird Server software. After having changed the location of the

database, you need to change the connection string in the software: Go to the Preferences screen, in the

Database connection field, enter the new address of the database. Click on save. The software needs to be

restarted.

For more information regarding the use of Firebird Server with your software, please contact our technical

support.
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